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2 AT-8900 Series Switch
Models Covered By This Reference

This Hardware Reference includes information on the following products:

■ AT-8948

■ AT-PWR01 (AC power supply unit)

■ AT-PWR01 (DC power supply unit)

■ AT-FAN01 (fan only module)

The latest AT-8900 Series Hardware Reference can be found at 
http:// www.alliedtelesyn.co.nz/support/at8900.

Why You Should Read This Reference

This reference provides hardware related information for AT-8900 Series 
switches, including information on power supply units.

The reference has two primary aims:

1. To familiarise you with the hardware features of AT-8900 Series switches 
and their Power Supply Units (PSU) units.

2. To assist you with setting up and maintaining your AT-8900 Series switch 
and PSU units. 

Keep this Reference (or its CD-ROM) in a safe place, you will need it if you purchase 
switch expansion options (DIMM) in the future.

This Reference does not cover software configuration or software installation 
procedures. For information on software, refer to the AT-8900 Series Software Reference.

AT-8900 Series

Printed Acrobat PDF Website

Documentation Roadmap

AT-8900 Series Safety and Statutory Information Booklet

AT-8900 Series Software Reference

AT-8900 Series Hardware Reference

AT-8900 Series Quick Install Guide

AT-PWR01 

Safety and Statutory Information

Quick Install Guide 

General Customer Support

Visit www.alliedtelesyn.co.nz for 
the latest documentation, FAQs, 
and support information.
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Hardware Reference 3
Where To Find More Information

The documentation and tools CD-ROM bundled with each switch contains the 
complete document set for AT-8900 Series switches and their power supply 
units, as well as tools for switch management. This includes the following:

■ The AT-8900 Series Statutory and Safety Information booklet, which provides 
safety and statutory information for the switch.

■ The AT-PWR01 Statutory and Safety Information booklet, which provides 
safety and statutory information for the power supply units.

■ The AT-8900 Series Quick Install Guide, which outlines the procedure for 
installing the switch.

■ The AT-PWR01 Quick Install Guide, which outlines the procedure for 
installing power supply units and fan only modules.

■ The AT-8900 Series Software Reference, which provides detailed information 
on configuring the switch and its software.

The documents listed here can also downloaded from the AT-8900 Series 
support site at http:// www.alliedtelesyn.co.nz/support/at8900.

Hardware Description

This section provides an overview of the hardware features of the AT-8948 
switch, the current representative of the AT-8900 Series switches.

Switch Overview
Developed to meet the exceptionally high performance demands of high end 
applications, the AT-8948 switch delivers wire-speed switching performance, 
in a robust 1U rack mount platform (See Figure 1).

Accessible on the front panel of the AT-8948 switch are these features: 

■ 4 Small form-factor pluggable (SFP) Gigabit Ethernet uplink sockets

■ 48 10BASE-T/100Base-TX RJ-45 ports bridging traditional copper/fibre 
divides

■ 1 compact flash socket

With an optional network processor accelerator card, accelerated IPv6 unicast 
and multicast routing is provided in hardware.

In addition, dual hot-swappable load-sharing power supplies provide space 
saving reliability and redundancy, perfect for the high-density rack 
environment where space is at a premium.
C613-03075-00 REV B
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4 AT-8900 Series Switch
Figure 1: Front and rear panels of the AT-8948

Dimensions

• Height = 44.5 mm (plus 5.1 mm if the rubber feet are used)

• Width = 440 mm (excluding rack-mounting brackets)

• Depth = 440 mm (excluding PSU handles)

• Weight = Not more than 8.5 kg (includes single PSU and PSU fan only 
module)

Mounting System

• 1U rack mounting; 19 inch rack-mount kit as standard

• Optional wall-mount rack kit

Environmental Conditions

• Operating temperature range: 0 to 50º C (32 to 122º F)

• Storage temperature range: -25 to 75º C (-13 to 167º F)

• Relative humidity range: 5 to 95% non-condensing

• Operational altitude: 3,050 metres maximum (10,000 feet)

Regulatory Standards

AC models

• EMC: EN55022 class A, FCC class A, and VCCI class A

• EN61000-3 levels 2 (Harmonics), and 3 (Flicker)

• Immunity testing to EN55024

• Safety: UL60950, CAN/CSA-C22.2 NO. 60950-00, EN60950, 
AS/NZS3260

• Certification: UL, cUL, TUV

DC models

• EMC: EN55022 class A, FCC class A, and VCCI class A

• Immunity testing to EN55024

• Safety: UL60950, CAN/CSA-C22.2 NO. 60950-00, EN60950, 
AS/NZS3260

• Certification: UL, cUL, TUV

49 50 51 52

AT-8948 Enhanced Layer 3+ Switch
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RESETFAULTPSU 1 PSU 2 CF

L /A
L /A
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LEDs

• Port and System status LEDs

• For a complete list of LEDs and their functions, see “LEDs and What 
They Mean” on page 24

Power Supply Unit

• PSUs are hot-swappable and load share

AC models

• Universal 100/240 VAC 47/63 Hz input

• Maximum continuous current draw, 2.2 A at 100 V, 1.1 A at 230 V

• Maximum inrush current (cold start at 25º C/77º F), 70 A at 240 V, 32 A 
at 115 V 

Important information for service personnel only:

CAUTION: double pole/neutral fusing

The ratings of fuses FH101 and FH102 is 250 V, 5 A

DC models

• 40 to 60 V, 48 V nominal

• Supports either positive grounded or negative grounded operation

• Maximum continuous current draw, 3.9 A at 40 V

• Maximum standby current, 100 mA

Switching Core

• Application-Specific Integrated Circuit (ASIC) switch chip

• Non-blocking L2 and L3 IP Switching

• 256 K IPv4 address table

• 4 K multicast table

• 4 K logical Layer 3 interfaces

• Shared 32 MByte DDR-SDRAM packet buffer

Processing Core

• 400 MHz RISC Processor

• 128 MBytes Synchronous DRAM (expandable to 256 MByte or 512 
MByte with DIMM)

• 32 MBytes of fixed flash 

• Compact flash socket for hot swappable expansion of flash memory up 
to 128 MBytes

• 512 kBytes of SRAM

• 32/66 PCI bus for 32 bit/33 MHz

• Silicon ID chip storing serial number, board ID, and MAC address
C613-03075-00 REV B



6 AT-8900 Series Switch
Asynchronous Serial Port

• Up to 115 kbps

• Universal Asynchronous Receiver Transmitter (UART)

• Standard RJ-45 connector

• Hardware-flow control

PCI Accelerator Card (PAC) Slot 

• For an optional 32-bit PCI based hardware Encryption and/or 
Compression Card

Network Processor Accelerator Card

• Optional network processor accelerator card provides accelerated IPv6 
unicast and multicast routing in hardware

• 4 K multicast table

• 1000 accelerator hardware filters

• 128 MBytes Synchronous DRAM giving 64 K IPv6 routes

Online Documentation

This section provides a step-by-step guide to accessing online documentation. 
Your computer must have Adobe Acrobat Reader installed to view online 
documentation.

Accessing the CD-ROM and Online Documentation

Follow these steps to access the CD-ROM and online documentation:

1. Insert the Documentation and Tools CD-ROM in the CD-ROM drive.

2. If the Welcome screen does not appear.

Select "Run" from the Start Menu (Windows 95, 98, 2000 or NT 4.0).

Type d:\start.exe (where d: is the CD-ROM drive letter) and click OK.

3. To view a document.

Click on the document title.

4. To navigate around PDF documents.

Use the toolbar buttons, keyboard shortcuts, or commands from the 
Document menu to page through the document.

Click on a bookmark, thumbnail or hypertext link to jump to a specific 
section or topic.

Use the Search command to search for keywords or phrases.

For more information about using the Adobe Acrobat Reader, select 
"Reader Guide" from the Help menu.

5. To install any of the tools included on the CD-ROM.

Click on a link in the Welcome screen. 
C613-03075-00 REV B



Hardware Reference 7
AT-TFTP Server

This section provides information on how to access and use AT-TFTP Server. 
AT-TFTP Server can be used to transfer configuration files as well as to 
download software patches and releases.

To use AT-TFTP Server, follow these steps:

1. If AT-TFTP Server has not yet been installed.

Install it now from the AT-8900 Series Documentation and Tools CD-ROM.

Choose AT-TFTP Server from the Start > Programs > Allied Telesyn > 
AT-TFTP Server menu.

2. To set preferences for the AT-TFTP Server.

Select "Options" from the File menu to display the "Set Preferences" dialog 
box.

The "Default file transfer directory" field specifies the directory that AT-
TFTP Server will read from or write to for file requests that do not include a 
directory specification.

To prevent unauthorised access to private directories, enter a path name in 
the "Restrict to directory" field. AT-TFTP Server will use only the specified 
directory, even if file requests contain references to other directories.

Select "Read only" to prevent files being written to the PC. To use the PC to 
archive scripts created using the switch's CREATE CONFIG command, 
select "Read Write".

Make any required changes and click "OK".

3. To load a file from AT-TFTP Server to the Switch.

On a terminal connected to the RS-232 Terminal Port (ASYN0), type the 
command:

LOAD METHOD=TFTP FILE=filename SERVER=ipadd DEST=FLASH

where filename is the name of the file to download and ipadd is the IP 
address of the PC running AT-TFTP Server.
C613-03075-00 REV B



8 AT-8900 Series Switch
4. To save a TFTP Server log.

Select "Save As" from the File menu.

TFTP requests are logged to the AT-TFTP Server main window.

Using Windows Terminal and Windows 
Hyperterminal

You can use a PC running terminal emulation software as the manager console, 
instead of a terminal. There are many terminal emulation applications 
available for PCs, but the most readily available are the Terminal and 
HyperTerminal applications included in Microsoft Windows 95, 98, 2000, and 
Windows NT 4.0. In standard Windows installations, HyperTerminal is located 
in the Start > Programs > Accessories menu.

The key to successful use of terminal emulation software with the switch is to 
configure the software and switch with matching communications parameters. 
The following procedures describe how to configure Windows Terminal and 
HyperTerminal for the default RS-232 ASYN0 settings on the switch, but the 
same principles apply to other terminal emulation programs.

To configure Windows HyperTerminal for Windows 95, 98, 2000, & NT 4.0.

1. In Windows, select:

• Programs > Accessories > HyperTerminal.

• Double-click the Hypertrm.exe icon.

2. In the Connection Description dialog box:

• Enter a name for the connection (e.g., AT89001)

• Select an icon from the scrolling list.

• Click “OK”.

3. In the Phone Number dialog box:

From the “Connect using:” drop-down list, select:

• “Direct to Com n” Where “COM n” is the COM port on the PC used to 
connect to the switch.

• Click “OK”.
C613-03075-00 REV B
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4. In the COMn Properties dialog box, set:

• Bits per second: 9600.

• Data bits: 8.

• Parity: None.

• Stop bits: 1.

• Flow control: Hardware.

• Click “OK”.

5. From the File menu, select:

• “Properties”

In the Connection Properties dialog box, click the Settings tab and set:

• “Function, arrow, and ctrl keys act as” to “Terminal keys”

• “Emulation” to VT100.
C613-03075-00 REV B



10 AT-8900 Series Switch
6. Click “ASCII Setup” to display the ASCII Setup dialog box. Uncheck:

• “Echo typed characters locally”.

• “Append line feeds to incoming line ends”.

Set other parameters as required.

• Click “OK” twice to close all dialog boxes.

7.  Save the current session. From the File menu, select:

• “Save”.

This creates a connection icon with the name you assigned in the 
HyperTerminal group. To use the configuration:

• Double-click the connection icon in the HyperTerminal group.

When the HyperTerminal window appears, press:

• [Enter] a couple of times.

The switch’s log in prompt will appear.

Switch Start-up

This section outlines the log in and start-up procedures for your switch. 
Although the switch will perform basic switching operations without being 
configured, you will need to go through these log in and start-up procedures if 
you wish to configure the switch and access its full layer 3 switching 
capabilities.

Before you can log in, the switch’s chassis must have at least one power supply 
unit installed and operational, with either a power supply unit or fan only 
module installed in the other bay.

To log In
To log in you must first connect the switch to a terminal or PC. This can be 
done using the RS-232 Terminal Port (ASYN0). A terminal cable suitable for 
use with ASYN0 is supplied with each switch.
C613-03075-00 REV B



Hardware Reference 11
Using the supplied terminal cable, or a cable you have made by following 
the instructions in “Useful Cables” on page 16, connect your terminal or 
PC to ASYN0 on the switch.

Set the communication parameters on your terminal or terminal emulation 
program to:

• Baud rate: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: Hardware

See “Using Windows Terminal and Windows Hyperterminal” on page 8 
for more information on configuring emulation software.

Ensure that any power switches are in the On position and that the switch 
is receiving power. 

After the switch has booted, the log in prompt appears. If the log in prompt 
doesn’t appear, press [Enter] two or three times.

When the switch boots for the first time it automatically creates an account 
with manager privileges. The account has the log in name “manager” and 
the password is “friend”.

At the log in prompt, enter the log in name and password.

Log in: manager

Password: friend

The switch’s command prompt appears and you can now configure the 
switch using the command line interface.

Change the password as soon as possible. Leaving the manager account with 
the default password is a serious security risk. Make sure that you remember 
the new password as there is no way to retrieve the password if it is lost.

Use the following command to change the account password:

set password

See the AT-8900 Series Software Reference for more information on 
configuring the switch.
C613-03075-00 REV B



12 AT-8900 Series Switch
To access help
Before help is used for the first time, the help files must be defined. 

To define the files, enter:

set help=help-filename

where help-filename is the name of a help file stored in flash.

To see a list of files stored in flash, enter:

show file

Help files have an HLP extension.

To display a list of help topics, enter:

help

To display help on a specific topic, enter:

help topic

Alternatively, type a question mark (?) at the end of a partially completed 
command to see a list of valid options.

Start-up Procedures
When the switch starts up following either a power cycle or an operator-
initiated reboot (using the Reset button or RESTART command), a series of 
start-up messages is sent to the terminal or PC connected to ASYN0 (Figure 2 
on page 12).

Figure 2: Switch start-up messages.

After the self tests are complete, the manager is given the option of forcing a 
mandatory boot from the EPROM (flash) release. The message:

Force EPROM download (Y)?

is displayed on the terminal or PC connected to ASYN0 and the switch pauses. 
If a key is not pressed within a few seconds, the start-up process will continue 
and all steps in the sequence will be executed. Pressing selected keys on the 
terminal immediately after the “Force EPROM download” message is 
displayed will change the switch start-up process (Table 1 on page 13).

INFO: Self tests beginning.
INFO: RAM test beginning.
PASS: RAM test, 131072k bytes found.
INFO: BBR tests beginning.
PASS: BBR test, 512k bytes found.
INFO: Self tests complete
INFO: Downloading switch software.
Force EPROM download (Y) ?
INFO: Initial download succeeded
INFO: Executing configuration script <boot.cfg>
INFO: Switch startup complete

Manager >
C613-03075-00 REV B
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During the start-up process the switch will generate four different types of 
messages. All messages are preceded by one of the words INFO, PASS, FAIL, 
or ERROR. The significance of these words is shown in Table 2 on page 13.

The possible messages and their meanings are:

INFO: Self tests beginning.

The code loader tests are about to begin.

INFO: RAM test beginning.

The RAM tests are about to begin.

PASS: RAM test, 131072k bytes found.

The RAM test passed, and the indicated amount of memory was found 
and will be used by the switch.

ERROR: RAM test 5. Error address = 00345678.

A RAM test failed, at the given address. In the example, it was the fifth 
test run. The RAM test repeats until it passes, so a number of messages 
like this may appear. This fault means that the memory system is faulty. 
If the fault continues, contact your Authorised Allied Telesyn 
distributor or reseller immediately.

INFO: BBR tests beginning.

The BBR battery tests are about to begin.

PASS: BBR test. Battery OK.

The BBR battery tests passed.

ERROR: BBR Battery low.

The BBR battery test failed, indicating that the battery is running low. 
The BBR battery will need to be replaced. Contact your Authorised 
Allied Telesyn distributor or reseller.

PASS: BBR test, 512k bytes found.

The BBR size/location test passed, with the indicated amount of BBR 
found.

Table 1: Switch start-up sequence keystrokes.

Pressing key... Forces the switch to...

[Y] Load the EPROM release, with no patch.

[S] Start with the default configuration. Any boot script is ignored.

[Ctrl/D] Enter diagnostics mode.

Table 2: Switch start-up message classes.

Message Meaning

INFO An action will be taken by the system.

PASS A test has been completed successfully.

ERROR An error message that a test has failed, but the system will continue to 
operate.

FAIL An error message that a fatal error condition has caused the system to 
halt in an unrecoverable fashion.
C613-03075-00 REV B



14 AT-8900 Series Switch
FAIL: BBR test. Error address = 12345678.

The BBR size/location test failed at the given location. The test at this 
location failed, indicating the end of memory, but a valid location was 
discovered in the 255 long words following this location. The BBR 
system will need to be replaced. Contact your Authorised Allied 
Telesyn distributor or reseller.

FAIL: BBR test, only 16k bytes found.

The BBR size/location test completed, but only the displayed amount 
of memory was found. This amount is less than the minimum required 
to run the switch software.

INFO: Self tests complete.

The start-up tests have finished.

INFO: Downloading switch software.

The process of downloading the switch software and vector table from 
ROM is about to begin.

ERROR: Code load retried.

FAIL: Code load failed.

The load of the code from ROM to RAM failed. The load is retried a 
number of times. Each time a failure occurs, the ERROR message is 
displayed. If the maximum number of attempts is reached, the FAIL 
message is displayed.

INFO: Initial download succeeded.

The start-up tests and download are complete, and the switch software 
is about to be started. If the default install is a compressed release, the 
release will now be decompressed. This may take a few seconds.

INFO: Downloading compressed release. This may take up to 1 
minute...

INFO: Loading software into memory. This may take up to 1 
minute...

The main switch software is about to be loaded into RAM. If the release 
is a compressed release, the release will be decompressed.

INFO: Executing configuration script <script-name>

The configuration commands stored in <script-name> are being 
executed. If an error is found in the script, one or more ERROR 
messages will be displayed.

INFO: Switch startup complete.

The start-up process is complete and the switch will now perform basic 
switching operations. Further configuration will be necessary if you wish to 
access the switch’s full layer 3 switching capabilities. See the AT-8900 Series 
Software Reference for detailed information on configuring the switch.
C613-03075-00 REV B
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RS-232 Terminal Port (ASYN0)

This section introduces the switch’s RS-232 Terminal Port (ASYN0), including 
its pin assignment and purpose.

The RS-232 ASYN0 Terminal Port is used to connect the switch to a 
management device for initial configuration and switch management tasks. 
This allows the switch’s software to be accessed from a terminal, or a PC 
running terminal emulation software. You can also use ASYN0 to establish a 
network connection from a remote site using SLIP and a modem.

ASYN0 has an RJ-45 socket with an industry recognised pinout. This requires 
the use of a straight-through RJ-45 cable with an RJ-45 DB9F connector when 
connecting the switch to a terminal or PC. The socket is wired as a DTE and the 
pin roles are shown in Figure 3 on page 15 and listed in Table 3 on page 15.

See “Useful Cables” on page 16 for more information on suitable cables to use 
with ASYN0. 

Figure 3: RS-232 Terminal Port Pin Numbers

Table 3: Internal DTE pin roles.

Pin Role

1 RTS

2 DTR1

1. DTR and DSR are connected together but have no other internal connection.

3 TXD

4 GND

5 GND

6 RXD

7 DSR1

8 CTS

1 8

RJPIN1
C613-03075-00 REV B



16 AT-8900 Series Switch
Useful Cables

This section describes how to make management, test, and network cables for 
use with the switch’s RS-232 (ASYN0) and RJ-45 interfaces. 

RS-232 Terminal and Modem Cables
The list of terminal and modem cables described in this section is shown in 
Table 4 on page 16. 

How to wire cables to connect a standard VT100 compatible terminal, or a 
modem, to ASYN0 is shown in Figure 4 on page 16, and Figure 5 on page 17.

Figure 4: Pin wiring diagram for a standard DB9 male to female terminal cable.

Table 4: Terminal and modem cable descriptions.

Cable type Description

RS-232 RJ-45 to DB9 female terminal cable Figure 4 on page 16

RS-232 RJ-45 to DB9 male modem cable Figure 5 on page 17

Notes:
(1) → Output from switch; ← Input to switch.
(2) Cable version 1.0.
(3)            Pin 4 unconnected.

RJ-45
(to switch/DTE)

DE9 Female
(to PC/terminal/DTE)

Ciscowiredrj45db9

(DTR) 2

(RXD)
(TXD) 3

6
(DCD) 7
(GND) 5

(CTS) 8
(RTS) 1

not connected

1
2
3
4
5
6
7
8
9

(DCD)
(RXD)
(TXD)
(DTR)
(GND)

not connected

(DSR)
(RTS)
(CTS)
(RING)

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female Pin View

18

RJ-45 Pin View
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Figure 5: Pin wiring diagram for a DCE RS-232 Terminal Port (DB9 male connector) 
male to male modem cable.

More information on pin assignments for the RS-232 Terminal Port can be 
found in “RS-232 Terminal Port (ASYN0)” on page 15.

Cables for RJ-45 Ethernet LAN Interfaces
For 10BASE-T/100BASE-TX/1000BASE-T (10/100/1000BASE) connections, a 
twisted pair cable with four pairs and RJ-45 connectors must be used. 

The cables used for network connections and testing of RJ-45 interfaces are 
listed in Table 5 on page 17.

Caution. Do not plug a phone jack into any RJ-45 port. Doing so could damage 
the switch. Use only twisted pair cables with RJ-45 connectors.

Notes:
(1) → Output from switch; ← Input to switch
(2) Cable version 1.0.

 
3 (TXD) 
2 (RXD) 
1 (DCD) 
5 (GND)
4 (DTR)
8 (CTS)
7 (RTS)
9 not connected
6 not connected

4
3
6
7
5
2
8
1

RJ-45 
(to switch/DTE)

DB9 Male
(to modem/DCE)

not connected
→ (TXD)
← (RXD)
← (CD)
    (GND)
→ (DTR)
← (CTS)
→ (RTS)
  not connected

RJ45DTEDB9Msw

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Male Pin View

18

RJ-45 Pin View

Table 5: Cables for RJ-45 LAN interfaces.

Purpose Interface type Cable type Pairs Pin assignment

Network 10/100/1000BASE Straight through Four Table 6 on page 18

Test 10/100/1000BASE Crossover or straight through Four Table 7 on page 19 or 
Table 6 on page 18
C613-03075-00 REV B



18 AT-8900 Series Switch
Pin assignments
For twisted pair cables each pair is identified by two different colours. For 
example, one wire might be red, and the other red with a white stripe. An RJ-45 
connector must be fitted to both ends of the cable. Figure 6 on page 18 
illustrates the pin layout for RJ-45 connectors.

Figure 6: RJ-45 Pin layout. 

1000BASE straight through cable
For 1000BASE network connections, all four pairs are used and the cable is 
wired in a straight-through configuration. This cable can also be used, in 
conjunction with the software test facility, to test 1000BASE network ports. 
Table 6 on page 18 lists the pin assignments.

1000BASE crossover cable
For 1000BASE test cables, all four pairs are used and the cable is wired in either 
a crossover or straight-through configuration. Table 7 on page 19 lists the pin 
assignments for a crossover cable.

Table 6: Pin assignments, 10/100/1000BASE-T RJ-45 four pair straight-through 
cable.

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 1+

2 Pair 1- 2 Pair 1-

3 Pair 2+ 3 Pair 2+

6 Pair 2- 6 Pair 2-

4 Pair 3+ 4 Pair 3+

5 Pair 3- 5 Pair 3-

7 Pair 4+ 7 Pair 4+

8 Pair 4- 8 Pair 4-

1
8

1
8

RJPIN
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Test Facility

This section introduces the Test Facility. The Test Facility is built into all 
AT-8900 Series software. For detailed information on operating the Test Facility, 
see the Test Facility chapter of the AT-8900 Series Software Reference.

Any interfaces being tested are dedicated to the Test Facility. The Test Facility 
can be thought of as a specialised interface module like PPP or Frame Relay.

Before using the test facility, disable any configurations 
(SET CONFIGURATION=NONE) and restart or reboot the switch.

Ethernet LAN Port Tests
A crossover cable is required to run an Ethernet LAN test. See “Useful Cables” 
on page 16 for details of how to make a suitable cable. To start the test, loop a 
four-pair crossover or straight-through cable between any two RJ-45 ports and 
enter:

ENABLE TEST INT=ALL

All interfaces connected by crossover cables are tested. Test results are 
displayed with the command:

SHOW TEST

which produces a display like that shown in Figure  on page 20. A more 
detailed output (with frame counts) can be displayed with the command:

SHOW TEST COUNT

which is shown in Figure  on page 21.

Table 7: Pin assignments, 10/100/1000BASE-T RJ-45 four pair crossover 
cable .

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 2+

2 Pair 1- 2 Pair 2-

3 Pair 2+ 3 Pair 1+

6 Pair 2- 6 Pair 1-

4 Pair 3+ 4 Pair 4+

5 Pair 3- 5 Pair 4-

7 Pair 4+ 7 Pair 3+

8 Pair 4- 8 Pair 3-
C613-03075-00 REV B



20 AT-8900 Series Switch
Figure 7: Example output from the SHOW TEST command .

Board      ID  Bay Board Name                          Rev    Serial number
----------------------------------------------------------------------------
Base      201      AT-8948                             P3-1   58364519

                                              Duration       Details
Interface  State    Result              Type  (minutes)  Data( %OK )  Control
----------------------------------------------------------------------------
  port1   no test     -                  -           -    -     -      -
  port2   no test     -                  -           -    -     -      -
  port3   no test     -                  -           -    -     -      -
  port4   no test     -                  -           -    -     -      -
  port5   complete  good                ALL          1   good(100.0)   -
  port6   no test     -                  -           -    -     -      -
  port7   testing   wait 2 minutes      ALL        < 1   good(100.0)   -   .
  port8   no test     -                  -           -    -     -      -
  port9   no test     -                  -           -    -     -      -
  port10  no test     -                  -           -    -     -      -
  port11  no test     -                  -           -    -     -      -
  port12  no test     -                  -           -    -     -      -
  port13  no test     -                  -           -    -     -      -
  port14  no test     -                  -           -    -     -      -
  port15  no test     -                  -           -    -     -      -
  port16  no test     -                  -           -    -     -      -
  port17  no test     -                  -           -    -     -      -
  port18  no test     -                  -           -    -     -      -
  port19  no test     -                  -           -    -     -      -
  port20  no test     -                  -           -    -     -      -
  port21  no test     -                  -           -    -     -      -
  port22  no test     -                  -           -    -     -      -
  port23  no test     -                  -           -    -     -      -
  port24  no test     -                  -           -    -     -      -
  port25  no test     -                  -           -    -     -      -
  port26  no test     -                  -           -    -     -      -
  port27  no test     -                  -           -    -     -      -
  port28  no test     -                  -           -    -     -      -
  port29  no test     -                  -           -    -     -      -
  port30  no test     -                  -           -    -     -      -
  port31  no test     -                  -           -    -     -      -
  port32  no test     -                  -           -    -     -      -
  port33  no test     -                  -           -    -     -      -
  port34  no test     -                  -           -    -     -      -
  port35  no test     -                  -           -    -     -      -
  port36  no test     -                  -           -    -     -      -
  port37  no test     -                  -           -    -     -      -
  port38  no test     -                  -           -    -     -      -
  port39  no test     -                  -           -    -     -      -
  port40  no test     -                  -           -    -     -      -
  port41  no test     -                  -           -    -     -      -
  port42  no test     -                  -           -    -     -      -
  port43  no test     -                  -           -    -     -      -
  port44  no test     -                  -           -    -     -      -
  port45  no test     -                  -           -    -     -      -
  port46  no test     -                  -           -    -     -      -
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  port47  no test     -                  -           -    -     -      -
  port48  no test     -                  -           -    -     -      -
  port49  no test     -                  -           -    -     -      -
  port50  no test     -                  -           -    -     -      -
  port51  no test     -                  -           -    -     -      -
  port52  no test     -                  -           -    -     -      -

  asyn0   no test     -                  -           -    -     -      -
--------------------------------------------------------------------------------

Figure 7: Example output from the SHOW TEST command (Continued).

Figure 8: Example output for the SHOW TEST COUNT command .

Board      ID  Bay Board Name                          Rev    Serial number
----------------------------------------------------------------------------
Base      201      AT-8948                             P3-1   58364519

                          Duration                   Frame Counters
Interface  State    Type  (minutes)         Tx    RxTotal     RxGood      RxBad
--------------------------------------------------------------------------------
  port1   no test    -           -           -          -          -          -
  port2   no test    -           -           -          -          -          -
  port3   no test    -           -           -          -          -          -
  port4   no test    -           -           -          -          -          -
  port5   complete  ALL          1   000100567  000100566  000100566  000000000
  port6   no test    -           -           -          -          -          -
  port7   testing   ALL          1   000107521  000107520  000107520  000000000
  port8   no test    -           -           -          -          -          -
  port9   no test    -           -           -          -          -          -
  port10  no test    -           -           -          -          -          -
  port11  no test    -           -           -          -          -          -
  port12  no test    -           -           -          -          -          -
  port13  no test    -           -           -          -          -          -
  port14  no test    -           -           -          -          -          -
  port15  no test    -           -           -          -          -          -
  port16  no test    -           -           -          -          -          -
  port17  no test    -           -           -          -          -          -
  port18  no test    -           -           -          -          -          -
  port19  no test    -           -           -          -          -          -
  port20  no test    -           -           -          -          -          -
  port21  no test    -           -           -          -          -          -
  port22  no test    -           -           -          -          -          -
  port23  no test    -           -           -          -          -          -
  port24  no test    -           -           -          -          -          -
  port25  no test    -           -           -          -          -          -
  port26  no test    -           -           -          -          -          -
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Other Interface Tests
Refer to the Test Facility of the AT-8900 Series Software Reference for information 
on testing other interfaces.

If a test fails, please contact your Authorised Allied Telesyn distributor or reseller.

Power Supply Units (PSUs)

At the rear of the AT-8900 Series switch chassis there are two power supply 
bays. AT-8900 Series switches allow for either one or two power supplies to be 
fitted (see Figure 9 on page 23). PSUs are hot-swappable and when two PSUs 
are fitted in a AT-8900 Series switch they will load share. PSUs contain fans 
needed to cool the AT-8900 Series switch. If only one power supply is fitted, a 
fan only module (FOM) must be fitted in the second power supply bay. Fitting 
two PSUs allows for power supply redundancy. 

port27  no test    -           -           -          -          -          -
  port28  no test    -           -           -          -          -          -
  port29  no test    -           -           -          -          -          -
  port30  no test    -           -           -          -          -          -
  port31  no test    -           -           -          -          -          -
  port32  no test    -           -           -          -          -          -
  port33  no test    -           -           -          -          -          -
  port34  no test    -           -           -          -          -          -
  port35  no test    -           -           -          -          -          -
  port36  no test    -           -           -          -          -          -
  port37  no test    -           -           -          -          -          -
  port38  no test    -           -           -          -          -          -
  port39  no test    -           -           -          -          -          -
  port40  no test    -           -           -          -          -          -
  port41  no test    -           -           -          -          -          -
  port42  no test    -           -           -          -          -          -
  port43  no test    -           -           -          -          -          -
  port44  no test    -           -           -          -          -          -
  port45  no test    -           -           -          -          -          -
  port46  no test    -           -           -          -          -          -
  port47  no test    -           -           -          -          -          -
  port48  no test    -           -           -          -          -          -
  port49  no test    -           -           -          -          -          -
  port50  no test    -           -           -          -          -          -
  port51  no test    -           -           -          -          -          -
  port52  no test    -           -           -          -          -          -

  asyn0   no test    -           -           -          -          -          -
--------------------------------------------------------------------------------

Figure 8: Example output for the SHOW TEST COUNT command (Continued).
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Figure 9: Rear panel of the AT-8948.

AC and DC power supplies are available. However, combinations of AC and 
DC power supplies are not supported. The AT-8900 Series switch will come 
with one PSU and one FOM as standard, with the second PSU being optional.

Each PSU and FOM will contain an EPROM allowing for command line 
interface identification of the modules. The EPROM will contain information 
including the type of module, serial number and revision of the PSU. This 
information will be available through the command line interface. 

To order additional power supply units, contact your authorised Allied Telesyn 
distributor or reseller for more information, or visit
http:// www.alliedtelesyn.co.nz/support/at8900.

The PSUs and the FOM that can be fitted in AT-8900 Series switches are:

■ AT-PWR01 (AC power supply unit)

■ AT-PWR01 (DC power supply unit)

■ AT-FAN01 (fan only module)

For PSU specifications see “Power Supply Unit” on page 5.

LEDs

• For each PSU bay there is one dual colour (green/red) LED situated on 
the front panel of the AT-8900 switch to indicate power supply status

• There are two LEDs on the rear panel of each PSU. An illuminated green 
LED indicates power good. An illuminated red LED indicates either fan 
failure or temperature exceeds the specified limit of 75 º C (167º F)

Controls

• Run/Standby switch DC version only

• Power switch recessed to prevent unintentional operation

Dimensions

• Height: 40.9 mm

• Width: 193 mm

• Depth: 130 mm

See the AT-PWR01 Quick Install Guide for information about power supply unit 
and fan only module installation procedures.

CAUTION: DISCONNECT POWER CORD PRIOR TO REMOVAL OF PSU
CAUTION: DISCONNECT ALL POWER CORDS TO DISABLE SYSTEM POWER

AC INPUT
100-240V
50/60Hz

3.0A

PWR
GOOD FAULT

AT-PWR01 AT-FAN01

FAULT
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Port, Connector, and Cable Combinations

This section provides cabling guidelines for each switch model.

1. Refer to the IEEE 802.3 standards for further cable information.

Troubleshooting 

This section provides information on how to detect and resolve problems with 
AT-8900 Series switches.

Other sources of useful troubleshooting information are:

■ http:// www.alliedtelesyn.co.nz/support/at8900

■ The AT-8900 Series Software Reference.

LEDs and What They Mean
The following tables outline how LEDs on AT-8900 switches report faults and 
operational activities. 

System LEDs 

Table 8: Cable guidelines for AT-8900 Series switches.

Model Port Type Connector Type Cable Type1 Maximum Cable Length

AT-8948 10BASE-T/100BASE-TX RJ-45 CAT5

CAT5E

120 m Max

AT-8948 1000BASE-X Varies with SFP Refer to user 
documentation 
packaged with SFP

Refer to user 
documentation packaged 
with SFP

Table 9: System LEDs found on all AT-8900 Series Switches.

LED State Function

PSU 1 Green PSU 1 is installed and supplying power to the 
switch, and the voltage output is within 
specification.

Red PSU 1 is installed in the switch, a fan has failed, 
or the PSU has exceeded its recommend 
temperature threshold of 75º C (167º F).

A FOM is installed in the switch and a fan has 
failed.

The bay is empty (no PSU or FOM installed).

Not lit A FOM is installed and the fan is good.
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AT-8948 Port LEDs

PSU 2 Green PSU 2 is installed and supplying power to the 
switch, and the voltage output is within 
specification.

Red PSU 2 is installed in the switch, a fan has failed, 
or the PSU has exceeded its recommend 
temperature threshold of 75º C (167º F).

A FOM is installed in the switch and a fan has 
failed.

The bay is empty (no PSU or FOM installed).

Not lit A FOM is installed and the fan is good.

Fault Red The switch or management software is 
malfunctioning.

1 Flash A switch fan has failed or is operating below 
the recommended speed. 

6 Flashes The switch’s temperature has exceeded the 
recommended threshold.

CF Green The compact flash memory is active. Do not 
eject the flash memory module.

Table 10: SFP Port LEDs on the AT-8948.

LED State Function

L/A 

(Link activity)

Green A 1000 Mbps link is open. The link is operating 
in full duplex mode.

Flashing green 1000 Mbps full duplex activity is occurring.

SFP 

(status)

Green A SFP transceiver is installed.

Flashing amber A SFP transceiver is installed but there is a 
transmission fault.

Table 11: 10/100BASE-T Port LEDs on the AT-8948.

LED State Function

L/A

(Link activity)

Green A 100 Mbps link is open.

Flashing green 100 Mbps activity is occurring.

Amber A 10 Mbps link is open.

Flashing amber 10 Mbps activity is occurring..

D/C

(Duplex/collision)

Green The port is operating in full duplex mode.

Amber The port is operating in half duplex mode.

Flashing amber Collisions are occurring.

Table 9: System LEDs found on all AT-8900 Series Switches. (Continued)

LED State Function
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PSU and FOM LEDs

Check these first
1. Check the power cord connections.

2. Check that the power supply voltage is stable.

3. Check that the correct data cables are being used and that their connections 
are secure.

4. Make sure that other network devices are working properly.

5. Use the SHOW INSTALL command to check that the latest software release 
is loaded. See the AT-8900 Series Software Reference for more information 
about obtaining the latest software release.

6. If the switch is malfunctioning, reboot it by pressing the recessed Reset 
button or entering the command RESTART REBOOT. Alternatively, shut 
down and restart the switch using its power switch (AC models) or 
run/standby switch (DC models).

Some common problems and how to solve them

Link/Activity LED on any port is off

This can indicate:

■ A loose data cable.

■ The device at the other end of the connection is not working properly or is 
turned off.

■ The data cable is not wired correctly.

■ The network administrator has manually disabled the port through the 
software.

■ The port’s selected transmission mode does not match that of the attached 
device.

Perform the following steps in sequence:

1. Make sure the data cable connections are secure.

2. Make sure the device at the other end of the connection is switched on and 
working properly.

3. Check that the data cable is wired correctly.

4. If you can, log in and check the port status. See “To log In” on page 10 for 
more information on how to log in.

Table 12: LEDs on the AT-PWR01 and AT-FAN01.

LED State Function

Fault Red There is either a fan failure, or the temperature 
has exceeded the specified limit of 75º C (167º 
F).

PWR Green A PSU is installed in the switch and is receiving 
power. The FOM does not have this LED.
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5. If the port is Enabled, make sure the transmission speed matches that of the 
connected device (auto-negotiating, full or half-duplex).

If the port is disabled, someone has used the software to manually disable it. You should 
find out why the port was disabled before enabling it.

Power LED is off

This can indicate:

■ A loose power cord.

■ A power supply failure.

■ A FOM is installed in that bay.

Perform the following steps in sequence:

1. Check that the power cord connections are secure.

2. Check that all switches and circuit protection devices are in the ON position.

3. Ensure that the supply voltage is within the operational range (100 to 240 
VAC 47 to 63 Hz for AC models, 40 to 60 VDC for DC models).

Fault LED is on

This can indicate:

■ There is a problem with the switch.

■ The switch or management software is malfunctioning.

■ A hardware fault is preventing switch start-up.

Perform the following steps in sequence:

1. Check “LEDs and What They Mean” on page 24 for descriptions and 
explanations of LED flashing sequences.

2. Reset the switch by pressing the recessed RESET button on the front panel.

3. If you were attempting to download software or manage the switch via the 
RS-232 Terminal Port, check that connections between the Terminal Port 
and local terminal or PC are secure.

If you cannot access the switch’s software because of a faulty RS-232 
Terminal Port connection, you can still manage the switch via Telnet or 
SNMP until the problem is fixed.

4. Download the latest software release. See the AT-8900 Series Software 
Reference for more information on how to obtain the latest software release.
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Expansion Options

This section provides an overview of the expansion options for AT-8900 Series 
Switches. The following expansion options were available when this Reference 
was written. See your Authorised Allied Telesyn distributer or reseller, or visit 
http:// www.alliedtelesyn.co.nz/support/at8900 to see if any new options are 
available.

Network Processor Accelerator Card

A network processor accelerator card should only be installed by authorised 
service personnel. Unauthorised opening of the switch’s lid may cause danger 
of injury from electric shock, damage to the switch, and invalidation of the 
product warranty. 

What is an accelerator card?
The network processor accelerator card is an optional plug-in card that 
provides accelerated IPv6 unicast and multicast routing in hardware.

A network processor accelerator card and a PCI accelerator card (PAC) cannot 
be installed in a switch at the same time.

The part number for the accelerator card approved for use with the AT-8900 
Series switch is:

■ AT-ACC01 network processor accelerator card

IPv6 is enabled with a special feature licence. To obtain a special feature licence contact 
an Allied Telesyn authorised distributor or reseller.

A network processor accelerator card and a PCI accelerator card (PAC) cannot be 
installed in a switch at the same time.

How an accelerator card works
The AT-ACC01 network processor accelerator card provides acceleration of 
routed IPv6 unicast and multicast packets. When the switch receives an IPv6 
packet to route, the packet is sent to the accelerator card. The packet is then 
processed by the accelerator card and sent out the correct port, with 
appropriate alterations to the packet. Other IPv6 functions are passed on to 
software, such as routing protocol control packets, encryption, authentication, 
and Hop-by-Hop headers.

You do not need to configure the accelerator card for the card to function. The 
accelerator card is enabled at installation.

You can disable the accelerator card and the switch then performs IPv6 routing 
in software.

To enable Quality of Service (QoS) functionality on the accelerator card use the 
hardware filter and the QoS commands. Detailed information about QoS 
functionality and hardware filters is in the Quality of Service (QoS) and 
Switching chapters of the AT-8900 Series Software Reference.
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How to check if an accelerator card is installed correctly
To confirm that the accelerator card is installed and operating correctly check 
that the switch has recognised the card. Turn on the switch and enter the 
command:

SHOW SYSTEM

to display system information. An example output is shown in Figure 10 on 
page 29.

Figure 10: Example output from the SHOW SYSTEM command (accelerator card installed)

Switch System Status                            Time 13:32:55 Date 16-Dec-2003.
Board      ID  Bay Board Name                          Rev    Serial number
--------------------------------------------------------------------------------
Base      201      AT-8948                             M1-0   58780985
Accel     210      AT-ACC01                            M1-1   58780852
PSU       212   1  AT-PWR01-AC                         M1-0   58365982
PSU       214   2  AT-FAN01                            M1-0   58494837
--------------------------------------------------------------------------------
Memory -   DRAM :131072 kB    FLASH : 32768 kB
--------------------------------------------------------------------------------
SysDescription
Allied Telesyn AT-8948 version 2.6.1-00 20-Aug-2003
SysContact

SysLocation

SysName

SysDistName

SysUpTime
336 ( 00:00:03 )
Boot Image      : at8948b.fbr size 860368 16-Dec-2003
Software Version: 2.6.1-00 20-Aug-2003
Release Version : 2.6.1-00 20-Aug-2003
Release built   : Dec 12 2003 at 10:29:27
Patch Installed : NONE
Territory       : europe
Help File       : help.hlp

PSU1: (AC)     Fan: OK    Temp: OK    Power: Good
PSU2: (FAN)    Fan: OK

Current Temperature : Good

FAN     Speed
---------------
1       Normal
---------------

Configuration
Boot configuration file: Not set
Current configuration: None

Security Mode   : Disabled

Warning (2048284): No patches found.
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The first section of the output shows details of the boards installed in the 
switch. There should details of the switch base card, the accelerator card if 
installed, and the type of power supply unit or fan only module installed. Both 
the part names and the serial numbers of the base card and accelerator card 
should be displayed.

If there is no entry for the accelerator card then the switch’s boot process has 
not correctly detected the accelerator card’s presence. The most likely cause is 
that the accelerator card is not correctly plugged into the slot on the switch’s 
base board.

Contact your authorised Allied Telesyn distributor or reseller if an accelerator 
card is installed in your switch but the correct details are not displayed in the 
output of the SHOW SYSTEM command.

Record the details of both the base card on the switch and the network processor 
accelerator card for later reference. If you have any difficulty with the network processor 
accelerator card at any time, contact your authorised Allied Telesyn distributor or 
reseller and quote the serial numbers of both the base card on the switch and the network 
processor accelerator card.

How to display information about the accelerator card
To display information about the accelerator card’s status and memory, use the 
command:

SHOW SWITCH ACCELERATOR

Figure 11: Example output from the SHOW SWITCH ACCELERATOR command

Switch Accelerator Configuration
---------------------------------------------------------------------------
Hardware Type .............. AT-ACC01
Mode ....................... IPv6 Acceleration
Status ..................... IPv6 active
Search memory size ......... 128 Mb
Counter memory size ........ 2 Mb
---------------------------------------------------------------------------
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Dual In-line Memory Modules (DIMMs)

DIMM should only be installed by authorised service personnel. Unauthorised 
opening of the switch’s lid may cause danger of injury from electric shock, 
damage to the switch, and invalidation of the product warranty. 

Only Allied Telesyn supplied DIMMS have been tested and approved for use 
with AT-8900 Series switches. Using DIMM that has not been approved may 
cause unreliable operation and will invalidate the switch’s warranty.

Synchronous DRAM for AT-8900 Series switches is provided by a single 
DIMM.

The following DIMM have been approved for use with the AT-8900 Series 
switch:

■ AT-SD128A-00 128MB SDRAM (installed at factory)

■ AT-SD256A-00 256MB SDRAM (upgrade)

■ AT-SD512A-00 512MB SDRAM (upgrade)

How to check if DIMM is installed correctly
The switch is unlikely to boot unless the DIMM is correctly installed. If the 
switch does boot but you suspect the DIMM is malfunctioning, enter the 
command:

SHOW SYSTEM

to display system information. An example output is shown in Figure 10 on 
page 29.

In the memory section of the output there should be an entry showing the size 
of DRAM. If the DRAM size is less than the size of DIMM that has been 
installed, then the switch has not correctly detected the DIMM. The most likely 
cause is that the DIMM connector is not plugged into its slot correctly. 

Contact your authorised Allied Telesyn distributor or reseller if the correct 
details are not displayed in the output of the SHOW SYSTEM command.

Record the switch’s serial number and revision details for future reference. If you have 
any difficulty with the DIMM at any time, contact your authorised Allied Telesyn 
distributor or reseller and quote the serial number of the base card on the switch.
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PCI Accelerator Card (PAC)

PACs should only be installed by authorised service personnel. Unauthorised 
opening of the switch’s lid may cause danger of injury from electric shock, 
damage to the switch, and invalidation of the product warranty. 

PCI Accelerator Cards (PACs) provide hardware data compression and 
encryption. A PAC is a hardware processing unit controlled by the switch’s 
CPU. 

A PCI accelerator card (PAC) and a network processor accelerator card cannot be 
installed in a switch at the same time.

Testing a PAC
There are several ways to check that the PAC is installed and operating 
correctly. First, check that the switch has recognised the card. Turn on the 
switch and enter the command:

SHOW SYSTEM

to display system information.

The first section of the output shows details of the boards installed in the 
switch. There should details of the switch base card, the PAC if installed, and 
the type of power supply unit or fan only module installed. Both the part 
names and the serial numbers of the base card and PAC should be displayed.

If there is no entry for the PAC then the switch’s boot process has not correctly 
detected the PAC’s presence. The most likely cause is that the PAC is not 
correctly plugged into the slot on the switch’s base board. 

Contact your authorised Allied Telesyn distributor or reseller if a PAC is 
installed in your switch but the correct details are not displayed in the output 
of the SHOW SYSTEM command.

Record the details of both the base card on the switch and the PAC for later reference. If 
you have any difficulty with the PAC at any time, contact your authorised Allied 
Telesyn distributor or reseller and quote the serial numbers of both the base card on the 
switch and the network processor accelerator card.

Next, check the PAC’s status using the command:

SHOW LOG

to display a log of PAC events. If any PAC tests fail, or the PAC does not operate 
correctly, contact your authorised Allied Telesyn distributor or reseller.

Once the PAC is operating, its functionality can be tested either by using the 
Test Facility software, which is built into the switch, or by configuring a 
module to use the PAC. For more information about configuring interfaces, see 
the Compression and Encryption Services chapter, AT-8900 Series Software 
Reference.
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Using the Test Facility to Verify Operation
The built-in Test Facility software is the easiest way to verify a PAC’s operation.

See the Test Facility chapter, AT-8900 Series Software Reference, for more information 
about the Test Facility.

To run the Test Facility for a PAC, use the command:

ENABLE TEST INTERFACE=PAC

The test will run for 4 minutes. To view the results of the test at any time, use 
the command:

SHOW TEST

The status of the test will be shown in the right-hand column. For further 
information on the meanings of the other figures, see the Test Facility chapter, 
AT-8900 Series Software Reference.

If you are unsure about running the Test Facility, or have difficulty evaluating 
the results, contact your authorised Allied Telesyn distributor or reseller.

SFP Transceivers
AT-8900 Series switches have 4 1000BASE-X small form-factor pluggable (SFP) 
uplink sockets on their front panel. SFP transceivers allow you to interchange 
port types to meet changing network requirements. SFP transceivers are hot 
swappable, fixed at full-duplex and fixed at a speed of 1Gbps. 

SFP transceivers can be purchased when a switch is purchased, or can be 
ordered separately as needed.

A range of SFP transceivers have been tested and approved for use with the AT-8900 
Series Switches. Contact your authorised Allied Telesyn distributor or reseller for more 
information.

The following SFP transceivers have been approved for use with AT-8900 
Series switches:

■ AT-MG8T 100m Base-T SFP

■ AT-MG8SX 300m SX SFP

■ AT-MG8LX10 10km LX SFP

■ AT-MG8ZX 70km ZX SFP

For the latest list of approved SFP transceivers, visit
http:// www.alliedtelesyn.co.nz/support/at8900.
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Installing and removing a SFP transceiver

Invisible laser radiation from disconnected fibres or connectors may be emitted. 
Do not look into SFP cables or transceivers.

To install a SFP transceiver:

■ Slide the SFP transceiver into the SFP socket

■ Press the SFP transceiver firmly into place

To remove a SFP transceiver:

■ Pull the button at the bottom of the SFP transceiver in to delatch the SFP 
transceiver (See Figure 12 on page 34)

■ Pull the SFP transceiver gently out of the SFP socket

Figure 12: SFP transceiver.

Compact Flash
AT-8900 Series switches have a compact flash socket on their front panel. 
Compact flash cards increase the flash memory available for file storage. 

Compact flash files can be manipulated using the command line interface. Any 
type of data, including releases, patches, GUIs and configurations can be stored 
on compact flash cards. However, release, patch, and GUI files cannot be run 
directly from compact flash. These files must be loaded into either NVS or 
onboard flash.

Data contained on compact flash cards can be read with any compliant reader. 
Do not keep sensitive data, for example keys, on compact flash cards.

SFP1

SFP uplink sockets

SFP transceiver

Delatch button
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The following compact flash cards have been approved for use with the 
AT-8900 Series switch:

■ AT-CF032A-nnn 32MB CompactFlash card

■ AT-CF128A-nnn 128MB CompactFlash card

Where n is the number of cards in a package, less than 1000. A package 
containing one card is 001.

For the latest list of approved compact flash cards, visit 
http:// www.alliedtelesyn.co.nz/support/at8900.

Compact flash cards used on the switch must support a hardware access time of no more 
than 100 nanoseconds. If a compact flash card does not meet the 100 nanosecond 
requirement it may not work as this is the maximum bus timing allowed.

Installing and removing a compact flash card
Compact flash cards can be inserted into the compact flash slot at any time. CLI 
messages are displayed when a card is inserted or removed. It takes 
approximately two seconds for an inserted card to be initialised. Messages 
notify the user when a card has been inserted: 

Info (1106257): Compact flash card inserted.

and when the card is ready for use:

Info (1106268): Compact flash card initialisation successful. 

A message notifies the user if the compact flash card is not compatible with the 
switch:

Info (3106300): Compact flash card initialisation 
unsuccessful.

When compact flash is in use, the compact flash Activity LED on the rear panel 
of the switch is green. 

Do not remove the compact flash card when it is being written to (that is, when 
the compact flash Activity LED is lit). Doing so will corrupt data on the file 
being written.

Testing a compact flash card
To display information about the basic state of a compact flash card, including 
card size, file count and serial number, insert the card and enter the command:

SHOW CFLASH

To display cluster ranges on a card, insert the card and enter:

SHOW CFLASH TEST 

Figure 13 on page 36 shows a sample output.
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Figure 13: Output from the SHOW CFLASH TEST command, when no test is 
running.

To test a card, insert the card and enter:

ENABLE CFLASH TEST START=startnumber END=endnumber

where startnumber and endnumber are positive integers within a cluster range. 
The endnumber must be higher than the startnumber. Cluster ranges are 
displayed in the output of the SHOW CFLASH TEST command (Figure 13 on 
page 36).

The test software will read the file allocation table and display a list of free 
sectors. Sectors can be tested as single sectors or as a range. The test will consist 
of a write/read/verify cycle. 

To stop the test, use the command:

DISABLE CFLASH TEST

To display the testing process while a test is in process, enter:

SHOW CFLASH TEST 

Figure 14 on page 36 shows a sample output.

Figure 14: Output from the SHOW CFLASH TEST command, when a test is running.

If used when testing is not active, the previous command displays blank 
cluster ranges on a compact flash card (Figure 13 on page 36).

Error messages are displayed when a file write fails. Failure could be due to the 
card being removed or an error in the card.

Clusters available for testing
        Ranges:
               [42645--61944]
        Number of free clusters  = 19300
        Number of ranges         = 1
        Number of used clusters  = 42645

Test Progress
        Starting cluster          = 700
        Ending cluster            = 1700
        Current cluster           = 1185

        Passed clusters number    = 485
        Passed sectors  number    = 1940

        Failed clusters number  = 0
        Failed sectors  number    = 0
        Used Clusters encountered = 0

        Duration................  4417 ms
C613-03075-00 REV B



Hardware Reference 37
Lithium Battery

The lithium battery should only be changed by authorised service personnel. 
Unauthorised opening of the switch’s lid may cause danger of injury from 
electric shock, damage to the switch, and invalidation of the product warranty.

There is a danger of explosion if the lithium battery incorrectly replaced.

Diagnostics

The switch software includes a set of diagnostic programs. These programs 
perform basic level checks of all system components. They do not run in 
conjunction with the normal operating code, and require that the system be 
totally dedicated to their use. A detailed knowledge of the way the switch 
hardware functions is necessary if diagnostics are to be used effectively.

The switch will not perform switching operations if diagnostics are running.

This section is not intended as a guide to the diagnostics software. Diagnostics 
are designed to be run by service personnel only. For more information, contact 
your Authorised Allied Telesyn distributor or reseller.

To enable diagnostics mode:

1. Connect a terminal to the RS-232 Terminal Port (ASYN0).

Using a terminal cable, connect a terminal to the RS-232 Port (ASYN0) on 
the switch. See “Useful Cables” on page 16 for more information on 
terminal cables.

Set the terminal communication parameters to the following:

• Baud rate: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: Hardware

2. Restart the switch.

Restart the switch, using an unbent paper clip, or something of similar 
dimensions, to operate the recessed reset button on the switch’s front 
panel, or by using the terminal to log in and enter the command:

RESTART REBOOT

See “To log In” on page 10 for more information on how to log in.
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3. Enable diagnostics mode during start-up.

During the switch start-up process, at the prompt:

Force EPROM download (Y)?

press [Ctrl/D] on the terminal to enter diagnostics mode. A banner page will 
be displayed on the terminal (see Figure 15 on page 38). This can be used to 
check that the terminal is correctly connected.

Performing a Full flash Test or erasing flash will delete all configuration and 
release files. Make sure you know how to reload these files before erasing flash 
or performing a flash test.

Figure 15: AT-8900 Series diagnostics banner page.

To run a diagnostic program, enter the corresponding letter or number (or key). 
There are several sub-menus to cover all the available options. Table 13 on 
page 38 lists the control keys for diagnostic operations.

A reasonable understanding of the system’s structure is needed to operate 
diagnostics and interpret the results.

To restore the switch to normal operation, use a pen or pencil to operate the 
recessed reset button on the front panel, or press “0” (zero) to restart.

Contacting Us

With locations covering all of the established markets in North America, Latin 
America and Europe, Allied Telesyn provides localized sales and technical 
support worldwide. To find our representative nearest you, visit Allied Telesyn 
on the web at: http://www.alliedtelesyn.com.

* * * Diagnostic Mode * * *

  version: 16-Mar-1998

Main Menu:
  0. Restart
  1. Full RAM test
  2. ROM checksum test
  5. Battery backed RAM test
Enter selection ==>

Table 13: Basic commands for running the diagnostics.

Key Function

Q Quits any running tests and displays the banner page.

S Prints a summary of test results so far.
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